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General Information 
Please scan the materials to familiarize yourself with the sequencing and flow of the course 
before beginning the assignments. Knowing what lies ahead will help you achieve maximum 
benefit from each individual assignment and the course, as a whole. 

Per FPU policy a minimum of one week per unit of study (three weeks, in this case) must 
transpire from your date of enrollment to the date your last completed assignment is 
returned to me for evaluation and grading. 

All grades must be submitted online to the university. When you have completed the course 
(shared all completed assignments and answered all the surveys) you will need to request 
online grading. To do so, please follow the directions found at the end of this workbook 
describing the process. Remember to request online grading when you submit your final 
assignments but no sooner, please. 

Students will be evaluated on the ability to follow directions as described in the workbook to 
complete assigned projects which demonstrate mastery of the tools and techniques. Written 
assignments should contain thoughtful, reflective responses applicable to their personal and/ 
or professional experiences which indicate they have put thought and effort in to their replies.

Kindly allot sufficient time for me to review your work and submit your grade to the university. 
Per FPU policy I am allowed up to 10 business days to accomplish this, though it rarely ever 
takes me that long unless I am out of town. Once I have reviewed your work and submitted your 
grade to FPU I will email you notification that your grade is in FPU’s hands awaiting posting.

I can not stress this enough - never hesitate to contact me - that's why I'm here! When 
contacting me e-mail is preferred, but if you need to phone please do so after 10:00 AM PT, 
being mindful of time zone differences, as early morning calls wake the family. Thanks for 
your cooperation and understanding. 

For information on the Fresno Pacific University Academic Policies and Procedures for 
Independent Study Courses, go to https://ce.fresno.edu and click the ‘CE Policies and 
Procedures’ link at the bottom of the page.
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Welcome

Get ready to explore the possibilities of creating computer graphics with Paint and Draw! 
From simple lines and shapes to sophisticated illustrations and classroom posters, you will 
learn to unleash the power of the computer to enhance and expand your graphics skills. This 
course is for everyone - you do not need to be an artist (or even artistically inclined) to use 
Paint and Draw programs to produce professional looking results.

All three programs used in this course are web-based and accessed through a web browser 
on a Chromebook, Mac or Windows computer. Please keep in mind that web-based pro-
grams are subject to changes, both minor and major, beyond control of the user. Differences 
in the functionality, look and toolsets of any given program is subject to change without no-
tice. I will do my best to 'keep up' with any changes and provide you with the most recent 
ilmages and directions for the relevant programs. If there are directions which do not 'fit' the 
current iteration of a program, please let me know and I will address it - thanks!

If you are using a laptop, you might want to consider using a mouse instead the trackpad. . . 
using Paint and Draw programs requires a bit of finesse, and some trackpads tend to be a bit 
temperamental. For those working on a computer, the mouse is preferred.

Please take time and review the entire workbook before 'jumping ahead' to the projects. 
Countless questions and periods of frustration on your part can be avoided if you familiarize 
yourself with the introduction and lead-in instructions to each project. 

As with my other courses, this one is built on a 'step-by-step' approach to learning. The pro-
cess may seem long winded when you are doing it, but you will be able to transfer your new 
skills and experience to a wide array of situations, whether you are creating for yourself or 
passing on your knowledge to your students, 

My hope is that you succeed and enjoy while learning. I appreciate, respect and rely on your 
candor in your feedback when completing the course evaluation. Your honesty would never 
effect your grade. On an ongoing basis I review and revise all my courses, especially new 
ones! Historically the changes made have been effected based on your recommendations. I 
really do listen!
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Course Website    

In addition to this workbook, there is a companion website containing links to all other resources 
you will need to complete this course. Type in this address into your web browser:

www.cbgraphics.steveyoungfpu.net
On the website you will note four columns of links. There are directions elsewhere in this 
workbook which refer to some of the links where relevant. Though not referenced in the 
workbook, I have included an 'Art Resources' column you may want to check out.

Utilizing the course completion checklist as a guide, you will be accessing the following links 
from the course website (listed in order):

Instructor Welcome Video
Pre-course Survey
Cloudpaint Website

PaintZ in the Chrome Store
Mid-course Survey

Google Drive Course Folder
Sketchpad.io Website

Lesson Plan Form
Standards Chart

Post-course Survey
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Retrieving Files For Assignments

Some assignments utilize pre-made elements. For example, with Paint Project # 6, you will 
be using the lasso tool to combine two images which requires moving the image of an eagle 
on top of a mountain background. These images, along with others, are in the 'Google 
Drive Course Folder' on the course website. 

Click on this link on the course website then add this 
folder to your Google Drive.

When you access your Google Drive, click on the 'Shared with me' icon. You will see a new 
folder, titled 'Paint & Draw for Teachers - Resources'. In it you will find files to be used with 
the PaintZ and Sketchpad apps later in the course.

This process will be detailed further after Paint project #6.
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While laptops typically use a trackpad to control the cursor, you may 
want to consider a mouse for graphics use. Some people (myself 
included) find the small-scale trackpad movements needed to 
draw images on the screen difficult, and using a mouse can help 
remedy this. 

If your laptop has a USB port, you should be able to plug in just 
about any mouse and it will start working. 

Wireless mice use bluetooth to communicate with the computer, and 
will not work on most Chromebooks. However, some wireless mice 
have a USB receiver which plugs into the Chromebook, which will 
work.

Computer Mouse 

You can find a wired mouse online (I checked 
Amazon.com and Walmart.com) for under $10.

Screen Captures
With some projects, you will need to take a screen capture of your work. Below are key-
board shortcuts for three main types of computers.

Chromebook:	 Ctrl (Control) + Switch window

Windows:		  Windows logo key + PrtScn

Use the Snippinng Tool for more efficient screen captures.

Macintosh:		  Cmd (Command) + Shift + 3
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The Trackpad

Computer graphics is a very tactile use of the computer - you will seldom use the keyboard 
at all. Your digital dexterity and fine motor control will certainly be put to the test! Trackpad 
usage varies according to the type of computer, but here are the basics:

To move the cursor, move one finger across the surface of the trackpad.

To drag a tool or object (i.e. draw with a pencil), 
while pushing the trackpad down (usually with a 
thumb) move another finger across the trackpad.

To Click on a Trackpad

To click (the same as clicking the left button on a mouse), briefly push down with one fin-
ger. Most trackpads will give an audible clicking sound.

To Right-Click on a Trackpad

To right-click on most trackpads, tap once on the trackpad using two fingers.

This will open the right-click options.
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Pre-course Survey 

To fill out and submit this form, please go to the Pre-
Course Survey link on the course website. I have cop-
ied the survey here merely for reference; you will submit 
your responses via the Course Website.  A copy of your 
completed form should be e-mailed to you after submit-
ted.  A couple brief, succinct sentences should suffice.

What grade and subject(s) do you currently 
teach?

What types of technology are currently available 
to you at your school? 

What prior experience, if any, do you have using 
a computer graphics program?

How are you or your fellow teachers currently 
using technology in the classroom?

Are you currently using computer graphics as part of your teaching?

Do you feel you and your students could make good use of computer graphics in your class-
room? How? 

What do you hope to get out of this course?
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Why Learn about Computer Graphics?

If you are taking this course, it's because you want to learn computer graphics! Each of you 
may have a different reason for being here, but we are all driven by the same desire: un-
derstanding how it works! This course was created to answer this particular question. Here 
you will learn the basic tools and techniques used to create artwork and illustrations on the 
computer. 

"All students benefit from learning in the arts—today and 
tomorrow. In the creative economy of the 21st century, 
arts education is vital. It helps students develop essen-
tial skills that prepare them to become the innovators, 
problem-solvers, and collaborators our world needs. 
National research shows that involvement in the arts 
has an immediate, positive impact on students—elevat-
ing academic performance, deterring delinquency, and 
raising graduation rates. According to the Center for 
Arts Education’s recent report, Staying in School, some 
students at risk of dropping out have cited involvement 
in the arts as their reason to stay in school. New neuro-
science research also documents the positive effects of 
arts learning on cognitive function."

https://www.arts.wa.gov/wp-content/uploads/2019/05/Booklet-Arts-Education-Re-
search-Initiative.pdf

For most students, art begins with crayons and clay. In the digital age, these have been re-
placed (I must say somewhat sadly) with tablets and computers. Using the already-in-front-
of-you devices for creative projects is of great benefit. Computer graphics is a 'lean forward' 
activity: one in which the user is actively engaged in creating content. Too often students are 
spending time with 'lean back' diversions, where they are passively consuming someone 
else's content.

This course will help you over the learning curve and prepare you to incorporate computer 
created graphics into your classroom. This can be in the form of stand-alone lessons or as an 
element of a larger project. Computer graphics can help students develop creative problem 
solving skills, motor skills, decision making and inventiveness. Integrating computer graphics 
with other disciplines can reach students who might not otherwise be engaged in classwork.

Plus, it's fun!

*Check out the art resourc-
es links on the course web-
site.
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Paint and Draw - What is the Difference?

There are two basic ways that a computer displays graphic information on a screen: bitmap 
and object. These two types are represented by two general kinds of computer graphics 
programs - Paint (bitmap) programs and Draw (object) programs. Some programs have both. 

A bitmap is a collection of dots, or pixels, that define an image. A bitmap can be of various 
bit depths and resolutions. Each pixel takes up one space on the monitor; there can not be 
two pixels in the same location. All the pixels are on the same layer - that is, no pixel can be 
in front of or behind another pixel. This is an important distinction between Paint and Draw 
programs. This type of graphic is also called a Raster graphic. 

With Draw, the computer sees images on the screen as mathematical objects, not a collection 
of pixels. This type of graphic is also called a Vector graphic. This allows for greater flexibility 
and accuracy in reshaping and moving images. 

For example, a one inch line in a Paint program is made up of 72 pixels in a row. Each pixel 
can be erased or moved independently of the others. The same line in a Draw program is a 
single piece of computer code telling the program the length, thickness and color of the line. 
There are no 'parts' to the line which can be individually accessed. You will not find an eraser 
in a draw program.

Drawing is better when: 

You want to rearrange layers of objects (in a 
painting, you cannot move items forward or 
backward).

You only need to draw basic shapes, lines, 
curves, and simple freehand objects (painting 
is better for more complex freehand images).

You want to easily re-select and manipulate 
objects (everything added to a painting 
becomes part of the overall canvas and is not 
as easily selected and manipulated).

You do not need to use paint-only features, 
such as blending colors, tinting, lightening, or 
darkening (you can add a painting frame to a 
drawing document if you need these effects 
in a portion of your document).
 

Painting is better when: 

You want to use the painting tools, such as the 
paintbrush, spray can and eraser, in addition 
to the drawing tools. (Many of the tools found 
in Paint are unavailable in Draw.)

You want to apply special effects to your 
images, such as blending colors, tinting, and 
lightening or darkening.

You want to insert a picture or graphic and 
use the painting tools and features to alter it.

You want to create freehand images that are 
more complex than simple shapes and lines.

You do not need to rearrange layers of 
items (you cannot move objects forward 
or backward in a painting, but you can in a 
drawing).
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A Paint program is distinguished by an image that is made up of individual pixels. A pixel is 
the most basic component of any computer graphic. Pixel stands for picture element. It cor-
responds to the smallest thing that can be displayed on a computer screen. Every computer 
graphic is made up of a grid of pixels. When these pixels are painted onto the screen, they 
form an image: this grid of pixels is called a bitmap. 

In the simplest terms, each pixel can be represented by 1 bit, a 1 if the pixel is black, or a 0 if 
the pixel is white. The computer opens a black & white bitmapped image. Then it starts look-
ing for numbers that describe image information. Every time it comes to a 0 it draws a white 
pixel. When it comes to a 1 it draws a black pixel. Color images simply have more bits per 
pixel. A 32 bit screen can have over 16 million different colors for each pixel.

A black & white
bitmapped image                                              

The same image,  magnified  to 
show the  individual pixels

Graphic File Types
When you save a file, part of its name is the extension. This three or four letter suffix tells the 
computer what program created it, and what program should (or can) open it. If you save a 
Word file, it  uses the .docx extension. Graphics programs also have extensions - here are 
the formats you may encounter in this course.

.png	 Portable Network Graphic; it is the most common format for web pages images

.jpg	 Joint Photographic (experts) Group; the second most common web format

.svg 	 Scalable Vector Graphics; a Draw format that can be enlarged without loss of quality

.bmp	 BitMap; Microsoft's image format (similar to a .jpg)

.psd	 PhotoShop Document; format wherein a document can contain layers and channels
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Paint Programs 
Here are the tool palettes of several of the many hun-
dred available paint programs. If you look closely, you 
will see tools common to all the programs. These tools 
will be the focus of this part of the course.

BrushZ Chrome App

Cloudpaint.com

sumopaint.com

chromecrxstore.com/onlinepaint
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Cloudpaint

Cloudpaint is a basic, classic computer graphics Paint program. I selected this program to 
start you off with because it utilizes tools in their simplest, most straight forward form. The 
interface is modeled after the first public, mouse-based graphics program - MacPaint.

You will be using just one portion in this web-based program, the Color screen (as opposed 
to Browse, Classic and Photo), only the 'Color' screen. 

Note: Occasionally Cloudpaint experiences technical difficulties - use the alternative Paint 
program referenced on the course webpage; it contains the same tools as Cloudpaint.

You can find the link to these programs on the course website:

 www.cbgraphics.steveyoungfpu.net

The tools contained in the four palettes are further described when you get to Paint Projects 
#1~3 and establish the basis for learning and using similar tools in other graphics programs. 
You will literally be starting at square one.

Tools

Colors

Patterns

Brushes



15Paint & Draw for Teachers

PaintZ

PaintZ is a simple Paint program for cre-
ating and editing artwork and other images, 
similar to Microsoft Paint. 

PaintZ is designed to be fast and easy to 
use, with a touch- and mouse-friendly inter-
face, full offline support, and no Flash Player 
required. 

This is one of the easier Paint programs to 
master. It has a limited set of tools, but is 
easy to understand and use.

Click the ? icon for help



16Paint & Draw for Teachers

Paint Tools 

Paintbrush Eraser Circle

Cloudpaint

PaintZ

Sketchpad Not Available

The next several pages illustrate various tools used in many Paint (bitmap) programs. There 
are literally hundreds of such programs, each with a slight twist of the same theme: creating 
graphics! All programs, whether on a Chromebook, Windows or Macintosh computer, share 
a common set of tools - pencil, paintbrush, eraser, spray can, and simple geometric shapes. 
Paint programs may be quite simple, including very few tools (like the Cloudpaint website), 
or highly sophisticated, such as the Adobe Photoshop program. 

Please do not think this course is designed to teach you a specific piece of software. Such is 
not the case. The purpose of this course is to teach you the tools and techniques common to 
the majority of computer graphics programs. I chose the three apps addressed in this course 
as they contain a good representation of graphics tools and functions.

The illustrations that follow are for a generic Paint program; the icons in whichever app or 
website you are using may look different. Keep in mind not all programs have identical 
tool sets. You my find some programs lack certain tools - for example, PaintZ does not have 
a Magic Wand tool, Sketchpad has no eraser. Rest assured, in the following projects all the 
tools to complete that project are available.
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Paint Brush

To use the Paint Brush:

Click to select the Paint Brush from the Tool Palette.

Select a color (if other than the default color black is desired) from the Fill Color Palette.

Move the cursor to the document and click once to paint a spot. Click and drag to paint a line.

To change the brush shape or size:

Click to select a shape from the Brush Palette.

You can also select a pattern 
from the Pattern Palette.

Pencil

To use the Pencil:

Select the Pencil from the Tool Palette by clicking on it.

Select a color (if other than black is desired) from the Fill Color Palette.

Click once to paint a single dot or drag the Pencil to draw a line.

Note: If the pencil (set to black) starts drawing on a black portion of the screen, it will draw white.
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Using The Pencil As An Eraser         =
To use the Pencil as an Eraser:

1.	 Select the Pencil from the Tool Palette.

2.	 Select white paint from the Fill Color Palette.

3.	 Zoom in with the magnifier tool. Click on the pixel(s) you wish to 'erase.' Click and drag to 
erase larger areas.     

To erase the whole screen, choose New... from the File menu.

Eraser 

To use the Eraser:

Click to select the Eraser from the Tool Palette.

Click to erase only what is beneath the Eraser, or click and drag the Eraser 
to erase large areas.

NOTE: If you change your mind or double-clicked the Eraser accidentally, 
choose Undo from the Edit menu before taking any other action. Undo 
applies to any single action you take.

NOTE: In Cloudpaint, there is only one level of undo - you can only undo one 
time per action. As I used to tell my students, "make as many mistakes as you 
want, just make them one at a time."
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Spray Can 

Use the Spray Can to “spray paint” the fill with color and / or a  pattern.

To use the Spray Can:

Click to select the Spray Can in the Tools Palette

Choose a color from the Fill Color Palette  

Click once to paint a spot, hold down the mouse button to spray, or drag to spray paint a 
stroke.

Paint Bucket

Zoom in on an image to look for gaps, and fill them with pixels. If the paint leaks, choose Undo 
from the Edit menu before doing anything else. 

TIP - If the area being filled isn't completely enclosed, the paint will leak into areas you didn't 
intend to fill. A closed shape is an area of one color or shape with an unbroken outline or 
perimeter. 

To fill an enclosed area:

Click to select the Paint Bucket from the Tool Palette.

Select a color and pattern. The Fill sample shows your selection. 

Position the tip of the Paint Bucket pouring spout over the area you 
want to fill, then click the mouse once.
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Shape Tools

The shape tools come in two styles, empty and filled. The left column has the 
empty shapes, meaning that the interior is transparent. The filled shapes are 
opaque and contain whatever color and/or pattern is selected.

Select a tool and drag from point A to point B in a document to define the size, 
shape and direction of the shape. 

Fill

Pen

Fill is the inside of the shape, surrounded by the Pen line. Certain 
attributes of each can be changed independently of the other.

Different Paint programs handle Pen and Fill differently. In Cloud-
paint, note the numeral '1' and '2' in the Color Palette. The '1' 
represents the fill color.

Left: Empty Circle Shape, Center: Filled Circle Shape (with a white 
fill) and Right: Filled Circle shape (with two different fill patterns).

The FreeForm Fill tool will automatically connect its beginning and ending points 
with a straight line and fill itself with the selected pattern.
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Selection Rectangle (Marquee)

To use the Selection Rectangle Tool:

Select the Selection Rectangle Tool (Marquee) from the Tool Palette. The pointer will look like 
a crosshair when you move it in to the work space.

Position the crosshair at a corner (usually the upper left-hand corner) of the image you want 
to select. With the mouse still depressed, drag down and to the right to define a rectangle, 
one which encompasses the image you wish to select.

When you release the mouse button you will know the selection is complete as it will now be 
surrounded by animated dotted lines (giving the appearance of 'marching ants') which will re-
main around the selection until the mouse is clicked somewhere other than inside the selection.

The Selection Rectangle Tool selects everything surrounded by it, not just the 
object. When repositioning the selected object(s) elsewhere in your document, 
it may obscure other objects, depending on where you place it.

Once something is selected, it can edited with any item in the Edit menu.

Lasso
To use the Lasso:

Select the Lasso from the Tool Palette. The pointer looks like a lasso when you move it into 
the working area.

Position the Lasso beside the image you want to select and drag the Lasso down and over 
to draw a loop around the image. 

When you release the mouse button, the image is selected. If you encircle several separate 
images with the Lasso, each image is selected individually.

Once something is selected, it can edited with any item in the Edit menu. 
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Select and Move

You select a paint image by using one of the following selection tools:

		  Selection Rectangle Tool

		  Lasso

		
		  Magic Wand

Use this tool:		  To select:

   Selection Rectangle	 A rectangular portion of an image

   Lasso			   Irregular shapes with the surrounding white space

   Magic Wand		  Adjacent pixels of the same color

To select and move an image:

Select the image using one of the selection tools.

Use the pointer (the icon will look like scissors) to drag the selected image to a 
new location.

Click outside of the image to deselect it.

Magic Wand

The Magic Wand is a type of a selection tool, but with limited and fairly specific uses. 

To select adjacent pixels of the same color:

Select the Magic Wand from the Tool Palette.

Click on an area that contains the color you want to select. You may need to Zoom in for more 
precision.

You can now use with any item in the Edit menu on the selection.
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Rotate
To rotate an image by 90°:

Select the image by surrounding it with the Selection Rectangle or Lasso. 

Choose Rotate from the Edit Menu.

Flip An Image

You can flip images horizontally (side-to-side), vertically (upside down), 
or both. 

To flip an image:

Select the image by surrounding it with the Selection Rectangle or Lasso. 

Choose Flip Horizontal or Flip Vertical from the Edit Menu.
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Copy and Paste (Duplicate)

The technique you use to copy an image depends on where you want to place the copy. If the 
copy will be near the original, duplicating is recommended. When the copy will be far from 
the original or in another document, copying and pasting is recommended. 

To copy and paste an image:

Select the image or the part of the image you want to copy by surrounding it with the Selection 
Rectangle, Lasso or Magic Wand.

Choose Copy from the Edit menu.

Choose Paste from the Edit menu. The copy appears in the document with a selection rectangle 
surrounding it.

Drag the copy to the desired location. You can paste as many copies as you like by repeatedly 
clicking the Paste button.

Drag to new location
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Paint Projects 

The following projects will progressively introduce you to the tools common to the majority of 
paint programs. Feel free to experiment; you can learn more from 10 minutes of playing than 
an hour reading an instruction manual. Keep in mind that it may take several attempts to 'get' 
a particular concept or technique. Stay below your frustration level, but keep trying! 

The first four projects are done in the most basic paint program addressed in this course, 
Cloudpaint. You have just reviewed some the basic tools in Cloudpaint.

Please feel free to embellish, personalize and expand on the assignments if you wish. It's not 
required but it sure makes grading much more enjoyable!
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Project 1:		  Transparent Cube 

Learning Objectives:	 Mouse / trackpad control
				    Selecting the appropriate tool
				    Using the fewest steps possible
				    Transparent shapes & objects

TIP: Generally, the larger the image you draw, the easier it is to 
control. Your boxes should be at least 2" wide - any smaller and 
you will be forced to work in a very small area.

Setup:	 Go to www.cloudpaint.com/color (or MacPaint)
	
	 If you have been playing with Cloudpaint, you can 

create a new, blank painting by going to the File menu 
and Choosing New. . .

Step 1:	 Click on the EMPTY SQUARE tool in the tool palette.

Step 2:	 Position the cursor in the middle of the screen.

Step 3:	 Press and hold the mouse button down. Slowly move the 
mouse down and right to define a square. Let up on the 
mouse button.

Step 4:	 Position the cursor in the middle of the square.

Step 5:	 Press and hold the mouse button down. Slowly	move the 
mouse down and right to define a second square. It should 
be the same size and shape as the first square you drew. 
Let up on the mouse button.

Step 6:	 Click on the LINE tool in the tool palette.

Step 7:	 Move the cursor to the upper left-hand corner of the first 
square. Hold the mouse button down to begin painting a 
line. Move the mouse (and the line) to the upper, left-hand 
corner of the second square, connecting the two.

Step 8:	 Following the steps in 7, connect the other three corners of 
the first square with their counterparts in the second square.

Step 9:	 Save your cube by taking a screen shot (see next page). 
Cloudpaint does not have a normal 'Save' function.
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Canvas: Project Submission
Once you are logged into your Canvas account and have accessed the Paint and Draw for 
Teachers course, click on module 3.1 Paint Project 1 (Transparent Cube) File Submission.

At the bottom of the resulting page, click the Add submission button.

Click the Upload icon or drag your finished project onto the 'Drag a file here' icon.

Click the Choose File button

Your file will be copied to your Canvas portfolio.

The process will be the same for all Paint and Draw projects.
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Project 2:		  Opaque Cube 

Learning Objectives:	 Mouse / trackpad control
				    Selecting the appropriate tool
				    Fewest steps possible

Setup:	 Go to www.cloudpaint.com/color (or MacPaint)

Step 1:	 Click on the SOLID SQUARE tool in the tool palette

Step 2:	 Click the WHITE cell in the PATTERNS palette.

Step 3:	 Position the cursor in the middle of the screen.

Step 4:	 Press and hold the mouse button or trackpad down. Slowly 
move the down and right to define a square. Let up on the 
mouse button/trackpad. You will see the square you cre-
ated.  

Step 5:	 Position the cursor in the middle of that square.

Step 6:	 Press and hold the mouse button/trackpad down. Slowly 	
move the mouse down and right to define a square of the 
same size and shape. Let up on the mouse button/trackpad.

Step 7:	 Click on the LINE tool in the tool palette.

Step 8:	 Move the cursor to the upper left-hand corner of the first 
square. Hold the mouse button/trackpad down to begin 
painting a line. Move the mouse (and the line) of the top 
corner of the second square.

Step 9:	 Following the steps in 7, connect the other three corners of 
the first square with their counterparts in the second square. 
This will make an opaque box but you're not done yet!

Step 10:	 Click on the ERASER  tool. Erase the lower middle horizontal 
line. Erase the middle vertical line. This will make a solid 
cube. You're done!

Remember to save (screen capture) your image. See page 8.
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Setup:	 Go to www.cloudpaint.com/color (or MacPaint)

Step 1:	 Click on the CIRCLE tool in the tool palette.

Step 2:	 Position the cursor in the middle of the screen.

Step 3:	 Press and hold the mouse button or trackpad down. Slowly 
move slightly down and right to define an oval. Let up on 
the mouse button/trackpad.

Step 4:	 Click on the LINE tool in the tool palette.

Step 5:    	 Move the cursor to the left side of the oval. Hold the shift key 
down to constrain the line to a straight line. Hold the mouse 
button down to begin painting a line. Move the mouse down 
to paint a vertical line.

Step 6:	 Again, holding the shift key down, paint the 
	 right-hand vertical line.

This project introduces the most powerful tools in computer graphics: the ability to copy and 
transform pictures on the screen. With little or no extra work, it is possible to turn one part 
of an image into a complete one. In nature, most things are symmetrical. So why draw both 
sides? Just draw one side, then let the computer do the rest of the work for you. 

Because the techniques in this exercise are so important, you should repeat them several 
times until you are comfortable with them. 

Project 3:		  Cylinder 

Learning Objectives:	 Selecting the appropriate tool
				    Copying a picture
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Project 3:		  Cylinder (continued)

Step 7:	 Click on the Selection Rectangle tool in the tool palette.

Step 8:	 Move the cursor above and to the left of the figure. Hold-
ing the mouse button/trackpad down, move down and to 
the right to surround the figure. Make sure the vertical 
lines extend down past the marquee selection.

Step 9:	 The next three steps are done using the Edit menu at the 
top of the window. With the selection still active, choose 
Copy and then Paste. This will place a duplicate of the 
selection at the top corner of the canvas. 

Step 10:	 From the Edit menu, choose FLIP VERTICAL. The dupli-
cate top of your cylinder is now the bottom!

Step 11:	 Move the cursor back into the selection (of the second 
image).  Hold the mouse button/trackpad down and drag 
the image to its new position, matching the sides of the 
cylinder. As long as you hold down the mouse button or 
continue to depress the trackpad, you may reposition the 
image. Once set, release the mouse button/trackpad.

Step 12:	 Move the cursor outside the selection. Note that the cur-
sor changes from an arrow to a cross. Click the mouse to 
deselect the marquee. You're done!

Remember to save (screen capture) your image. See page 8.
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Setup:	 Go to www.cloudpaint.com/color (or MacPaint)

Step 1:	 Click on the CIRCLE tool in the tool palette.

Step 2:	 Position the cursor in the middle of the screen.

Step 3:	 Press and hold the mouse button/trackpad down 
down. Slowly move the down and right to define an 
oval. Let up on the mouse button/trackpad.

Step 4:	 Still using the circle tool, draw a small circle toward 
one end of the oval. This will be the eye.

Step 5:	 Click the SOLID CIRCLE tool and then the BLACK 
cell in the PATTERNS palette.

Step 6:	 Still using the circle tool, draw an even smaller oval 
inside the eye circle. This will be the pupil.

Step 7:	 Select the PENCIL tool from the tool Palette.

Step 8:	 With the pencil tool, you are in freehand drawing 
mode. Position the cursor at the appropriate places 
and draw ventral and dorsal fins then a tail on your 
fish figure. It doesn't have to be perfect!

	

NOTE: It is important to note where 
the pencil is positioned. If the tip of 
the pencil is on a white pixel, a black 
line is produced. If the pencil tip is 
touching a black pixel, a white line is 
produced. Be aware of this, and start 
the fins slightly off the oval.

Project 4:		  Fish

Learning Objectives:	 Choosing the right tool
				    Using the paintbrush
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Project 4:		  Fish (continued) 

Step 9:	 Click on the ERASER tool in the tool palette. Erase 
the line segments where the tail fin and side fin over-
lap the body.	

	 TIP: You can also use the paintbrush (with white 
paint) as an eraser. You can also use the PENCIL as 
an eraser, as its default color on selection is white. 
Just place the pencil tip on a black pixel, and it will 
'erase' the black lines (replace the black pixels with 
white). But to do this you'll need to  ZOOM IN to get 
a closer view of the lines you wish to erase. Click 
the magnifier glass tool (+ zooms in, - zooms out) 
then click the image. If you are using a trackpad, 
pinch - zooming enlarges the entire webpage - the 
image will be larger but the tools will be off-screen 
until you zoom back out..

Step 10:	 Click on the PAINT BRUSH tool from the tool palette.

Step 11:	 Then click on (select) the SCALE 	PATTERN from 
the PATTERN palette.

Step 12:	 Paint on some scales (by dragging the cursor) - just 
enough to give the impression of fish skin. You can 
also use the SPRAY CAN tool and spray on the 
scales but this method is much slower and less ef-
ficient. I suggest dragging the PAINT BRUSH! 

You're done!

Remember to save (screen capture) your image. See page 8.
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PaintZ

For the next two Paint projects, we will move from the very basic Cloudpaint to the newly 
updated PaintZ. You will note that the tool palette is set up differently than Cloudpaint, but 
the tools should look familiar. 

To open PaintZ,  type in https://paintz.app into your browser or use the hyperlink on the 
course webpage.

Click the ? icon for the 
HELP menu.

Project 5:		  Face
Learning Objectives:	 Using the circle tool
					    Using Pen and Fill

Setup:	 In the Chrome browser, go to paintz.app

Step 1:	 Click on (select) the OVAL tool from the tool 
palette. Place the cursor on the document and, 
with the mouse button/trackpad still depressed, 
move the cursor down and diagonally to create 
a circle about 2"~3" in diameter. 

		 The default when you open PaintZ is a black pen and white 
fill. This means that the circle tool will have a black (as op-
posed to another color) outline and a solid 
white interior. The default thickness of the 
line is set at 2 points. You can change the 
thickness by using the control.

Step 2:	 Next, position your cursor where you would like the tip of 
the nose to start. Move the cursor slightly down and over 
(right) to create an oval (nose). Repeat the same process 
for the shoulder and ear moving the cursor down and over. 

		 By using opaque white fill, the nose and shoulder ovals 
mask the larger circle (the head), saving you the trouble of 
erasing the underlying lines. 

	 Use Undo to reverse the last 20+ actions.

PaintZ has tooltips: if you hover the 
cursor over a tool, the name and key-
board shortcut of that tool will appear.
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Step 3:	 The eye is done in two parts; the eye and the pupil. For 
the eye, continue to use the circle tool and place the eye 
in the appropriate position.

Step 4:	 Change the fill color to black. To do this, alt-click the black 
circle to the right of the pen/fill indicator. If you are using 
a mouse, you can right-click. 

	 	

Create a pupil inside of the larger eye shape.

Step 5:	 Repeat the process for the second eye. To change back 
to a white fill, alt-click (or right-click with a mouse) the 
white color circle. 

Step 6:	 Choose the paintbrush tool. The line thickness should still 
be set to the default 2 points. Draw a mouth and any small 
details you may wish to add.

Step 7:	 Choose the eraser tool and set the fill color back to white 
(the eraser is actually a paintbrush). Change the size of 
the eraser to 18 or so, making it larger. Erase the left side 
of the ear, and the bases of the nose and shoulder ovals.

Step 8:	 To save your image, click the save icon. Give 
your image an identifiable name (i.e. face) and 
click the Save button. The file will be saved to the 
downloads folder where it can then be transferred 
into your shared Google Drive folder.

Outline

Fill

Remember to save and title your 
image. See pages 28 - 29
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Importing images From Google Drive
This assignment uses a pre-made element. You will be using the lasso tool to combine two 
images. These images, along with others, are in the 'Google Drive Course Folder'. 

Project 6:		  Eagle and
				    Mountain
Learning Objectives:	 Uploading images 
				    Photo editing
				    Using the lasso tool
				    Changing an image
				    Adding text

Setup:	 Open PaintZ,  type in https://paintz.app into your browser or use the hyperlink 
on the course webpage.

If you are using a Mac or a Windows computer, see next page for Step 1

Step 1:	 (Chromebook) Click the Open Image button at the upper left.

		  You will see the Google Drive screen. 

		  Click on 'Google Drive', then 'Shared with me' 

There may be other files in the folder, but PaintZ will only show files it can work with.
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Importing images From Google Drive (Mac or Windows)

This assignment uses a pre-made element. You will be using the lasso tool to combine two 
images. These images, along with others, are in the 'Google Drive Course Folder'. 

Step 1:	 Open the course website at cbgraphics.steveyoungfpu.net 

  		  Click the 'Google Drive Course Folder' link at the bottom of the left column. This 
connects you to the course Google Drive folder, containing several resource files.

 		  (Mac) Right-click the 'Eagle and Mountain' file and choose the 'Download' option 
from the drop down menu The image will be saved in the default location, probably 
in the Downloads folder. Depending on your Mac, the file might save to the Desktop.

		  (Windows). Each thumbnail image has a white arrow in 
the upper left corner. Click the icon and the image will be 
saved in the default location, probably in the Downloads 
folder.

In PaintZ, click the 'Open' icon. Open the 'Downloads' 
folder, then select the 'Eagle and Mountain' image which 
you just downloaded. Click the 'Open' button to import 
the image into PaintZ.
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Step 2:	 Using the freeform selection (lasso) tool*, carefully 
trace the edges of the eagle. This may take several 
tries - remember you can use undo - it does not 
have to be 'perfect' by any means. You are learn-
ing a technique, not perfecting your coordination! Clicking 
another tool and then clicking the lasso again will 'reset' 
and let you start fresh. TIP: Using the zoom control at the 
bottom right of the window may help to see detail in the 
eagle image.

After you have lassoed the eagle, the selection tool palette 
will appear.

Note the dotted line creating a box around the selected area.

Step 3:	 Zoom back out so both the eagle and mountain images are 
on-screen. With the cursor inside the selection box, drag 
the eagle downward and place it in the bottom left corner 
of the mountain image. 

		  Remember Undo is your friend! It may take several tries 
before you are satisfied with your selection and 
placement of the eagle. You can also reload the 
file (step 1) and start from scratch.

		  To 'clean up' the image if desired, use the 
selection box to surround the eagle/mountain 
image and then click the crop tool.  

*In other programs, especially those designed to run on Windows and 
Mac computers, the lasso tool will automatically adjust itself, shrink-
ing to the exact shape of the object lassoed. The inability to do so 
in PaintZ is a limitation of web-based computer graphic programs.

From left to right: 
Erase
Cut
Copy
Duplicate
Crop.
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Step 4:	 Select the Text tool which will cause the text control tools to 
appear. PaintZ has now become a basic word processor! 
There are options to change font, size, style and color.

		  Adjust the size to 48 pts and set the pen color to a light 
color by clicking a color sample. The outer ring on the color 
disk will reflect your choice.

	 The text tool is used to define a rectangle within which text 
can be typed. The size and position of the text box can not 
be adjusted once  set. This is a limitation of Paint programs. 
Later you will use text in a Draw program. There you will 
see the stark difference.

Step 5:	 Create a text box in about the same position and size as illustrated. Immediately 
after the box is drawn, type in the word 'wildlife'. Again, the Undo tool is your friend.

To save your image, click the save icon. Give your image an identifiable name (i.e. 
Eagle) and click the Save button. The files will be saved into the downloads folder 
where they can then be transferred into your shared Google Drive folder.

Remember to save and title your 
image. See pages 28 - 29
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Mid-course Survey 

To fill out and submit this form, please go to the Pre-Course 
Survey link on the course website. I have copied the survey 
here merely for reference; you will submit your responses 
via the Course Website. 

A copy of your completed form should be e-mailed to you after 
submitted.  A couple brief, succinct sentences should suffice.

What prior experience do you have using a Paint 
or Draw program to create artwork on a computer?

What are you first impressions of the assignments? 
Are they too easy or difficult? Please explain your 
answer.

Are you able to put your prior computer experience to use in completing the assignments 
thus far?

At this point in the course, are you envisioning your students making use of the skills you are 
learning now? If so, how?
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Draw Tools 

We now move to the second type of computer graphics, Draw. Let us examine the difference 
between a Paint program and Draw program. That was a 2 
inch long line. In a paint program, the computer sees that not as a line, but as hundreds of 
pixels lined up in a row. Each pixel is separate and distinct from the others, so the line is not 
really a line at all (it just looks that way); it is simply a row of dots.  A draw program sees the 
line as one object which is why draw programs are sometimes called object oriented or vec-
tor graphics programs. Each object, no matter how complicated, is a single unit. Because of 
that, there is no eraser in draw. In Paint you can erase individual pixels which make up an 
object or a figure. In Draw, it is 'all or nothing' as you can't erase part of a single unit. 

The chief advantage of Draw is you can change elements of your picture after you have 
created them. Just coming from the Eagle and Mountain Paint exercise, I am sure you can 
appreciate the advantage!

Draw programs use LAYERS. Draw sees each object on its own unique layer that can be 
placed above or below other objects (which also have their own layers). Think of each object 
as a playing card that you can shuffle up or down in the deck.

The eraser, spray can, magic wand, paint bucket and pencil tools are not available in 
draw (you just might miss that eraser!). 

To select objects, Draw programs have a SELECT tool. By clicking 
on the select tool, then clicking an object, that object is selected (so 
you can then manipulate it as you did once you selected an object 
in paint with the lasso or marquee). 

In Draw, a selected object has handles. They appear as shapes 
bounding the object. With the arrow tool on top of an object, holding 
down the mouse button/trackpad will allow you to drag the object, 
moving it around the document. With the tip of the arrow touching 
a handle, you can resize, reshape and rotate an object. Pressing 
the delete key will erase a selected object. TIP: Holding the shift 
key down will allow you to select (click on) several objects at once.

Enlarge / Reduce
Move

Rotate

Stretch Horizontally

The handle will turn green when 
the cursor is correctly positioned
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PrimalDraw

Draw Programs 

Here are the screens of several draw programs. 

Sketchpad
https://app.diagrams.net

Adobe Illustrator (for Mac and PC)
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Sketchpad

Sketchpad is a free online Draw program which will be used for the following six projects.

In addition to an array or Draw tools, Sketchpad has a library of thousands of high quality 
vector images to use in your project. All images are open source and available for use in pro-
fessional and commercial artwork. Sketchpad also has some great 'artsy' tools for making 
designs and abstract images. Take a few minutes to review the help screen and watch the 
short demo videos of each tool.

To open Sketchpad, use the link on the course website or type in sketch.io/sketchpad into 
your browser.

Click the ? icon for the HELP menu.

Tutorials are in the form of short videos, 
providing an easy, fast learning curve. 
The projects in this section assume 
that you have viewed the videos and 
have acquainted yourself with them.

NOTE: Sketchpad uses 'Live' buttons, 
and their appearance may differ from ses-
sion to session.

Sketchpad has tooltips: if you hover the 
cursor over a tool, its name will appear.

Sketchpad has a wide 
assortment of shapes.
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Draw Projects		
The next projects will progressively introduce the concepts and tools of Draw programs. I would 
ask you to recall the previously discussed differences between Paint and Draw programs. 
This next section is designed to demonstrate these differences in a way you can come to 
appreciate and respect as you discover the idiosyncrasies, subtleties and nuances of both 
Paint and Draw.

I have found some people prefer Paint and some Draw. Personally, I believe these prefer-
ences to be individual, and somewhat tailored to the skills and preferences of each user. I 
have had many complete this course and strongly favor the Paint tools and techniques, yet I 
have found just as many would rather Draw than Paint. One of the benefits of this course is 
the exposure you are getting to both Paint and Draw software!

Feel free to experiment! You can learn more from 10 minutes of playing than an hour reading 
an instruction manual. Keep in mind that it may take 5 or 10 tries to 'get' a particular concept 
or technique. Stay below your frustration level, but keep trying!  

And please remember, just like Paint apps, there are many Draw apps available. Sketchpad 
is an excellent start, but you may settle on another app for day-to-day use. You may already 
be using Google Draw - in that case I hope you will find some new ideas and techniques.
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Project 1:		  Shapes and Layers
Learning Objectives:	 Using shape tools
				    Working with Fill
				    Working with Layers	

Setup:	 In the Chrome browser, go to sketch.io/sketchpad 
Use the default settings. Make sure the 
Tools are visible by clicking the Tools 
icon. Click + to open a new document.

Step 1:	 Click on the Shape tool. It probably looks 
like a star, but the menu icon will  change 
depending on what shape is selected.

	 Click the small triangle to show the shape palette.

	 On the canvas (the part of the screen where you will 
draw) drag the mouse (or click and hold your finger if 
you are using a trackpad) to make a shape.

Step 2:	 Click the Select tool and click (or touch) the shape 
so the handles appear. (Refer to the bottom of p.48). 
Practice re-sizing and re-shaping the star.

Step 3:	 Select at least four other shapes and create a total of 
five images on your canvas.

	 To remove an image, click on the Select tool, click on 
the relevant image, then press the backspace / delete 
key on the keyboard. 

Remember the Undo button.

Shapes have other settings, 
such as setting the number 
of sides for a polygon. With 
a shape selected using the 
Selection tool, click the 
Styles tool to view the op-
tions.
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Project 1:		  Shapes and Layers (continued)

Step 4:	 Click on the Select tool, then click one of your shapes.

	

Experiment with different colors and patters on each of your five 
shapes. With one shape selected, you can change its color as 
many times as you like.

Remember the deck of cards analogy mentioned earlier; you can 
shuffle the order of the layers. Upper layers will cover lower layers. 
If you want the heart in front of the star, simply click the 
star with the Selection Tool, click the Options button, 
and select the Send to Front option.

Note the Fill and Outline (Pen) controls appear. The top control, 
Fill, is set to transparent. Note the line through the droplet icon. 
Clicking on the droplet turns the fill transparency on and off.

Click the Fill droplet icon to turn OFF transpar-
ency.

Click the small triangle to show the color palette. 
The palette is divided into four sections: Color, Linear, Radial and 
Pattern.

Clicking on each section will show its palette.
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Project 1:		  Shapes and Layers (continued)

Step 5:	 To save your image, click the Export icon. For you youngsters out there, 
the icon represents a floppy disk. Back in the day, it was the only way to 
save data. If memory serves, they each held a whopping 1.4MB. It would 
take 7,354,396 floppy disks to make the equivalent amount of storage space 
on the computer I am using to write this course.!!!

		 The Save dialog box will appear with several formats in 
which to save.

		 JPG and PNG are file types shared with Paint images.

		 SVG files are in Draw (Vector Graphic) format, but com-
press the document to a single layer.

		 Sketchpad format is native to the program, and saves all 
the document information, including layers. You would save 
a document in this format if you wanted to alter it later.

		 I would recommend saving in .png format so you can 
use the images in other programs; perfectly fine with me!

		 Give your image an identifiable name (i.e. Shapes, Draw Project 1, etc.) then click 
the Save button. The files will be saved into the downloads folder where it can 
then be transferred into your self-named TECH 912 portfolio folder. If you wish to 
upload the project immediately, see pages 28 & 29.
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Project 2:		  Art Brushes

Learning Objectives:	 Using brushes
				    Duplicating objects
			   Using Layers 

Setup:	 In the Chrome browser, go to sketch.io/sketchpad. 
Click the + icon to create a new document. 
Sketchpad lets you decide the size the new 
document, and if it is going to be blank or have a 
background pattern. Choose 'Size of Screen' (from 
the pull down menu) and 'Blank' for this assignment.

Step 1:	 Select the Brushes tool, then click the triangle to show 
the Brushes palette (here are many more than are I 
illustrated here). 

Step 2:	 Have fun experimenting! Doodle a design or picture using a 
number of brushes. Change the color and other settings, as you 
did with Project 1. Play, start over, move, resize, layer to your 
heart's content. Remember the help videos give examples of 
what each brush does. (I think the sketchy brush is my favorite)

Step 3:	 At some point, draw a final image.

Step 4:	 Give your image an identifiable name (i.e. Brushes) and click 
the Save button. The files will be save into the downloads folder 
where it can then be transferred into your portfolio folder. Refer 
to step 5 on the previous page.
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Project 3:		  Face

Learning Objectives:	 DRAW versus PAINT
				    Duplicating objects
				    Hiding parts of objects

Setup:	 In a browser, go to sketch.io/sketchpad. Click + to open 
a new document. Click to select the Shape tool. 

Step 1:	 Select the Ellipse tool, chose white fill and 
black outline by clicking the Adjustment tool.

	If you recall, you have already completed this project in 
Paint - redoing it in Draw will give you a good indicator 
of the difference between the two formats.

Step 2:    	 Draw five ovals, representing one eye, nose, ear, 
head and shoulder. Switching to the Selection tool, 
position and resize the ovals.

Step 3:	 Change the Fill color to black in the Adjustment 
menu and draw a small oval for the pupil of the 
eye. With the selection tool, move the black oval 
into the eye shape. 

	 To make both eyes exactly the same, use the  
Duplicate command from the Options menu. 
Repeat for both the eye and the pupil.

Step 4:	 Reposition the eyes on the face to your liking.
	 TIP: There is no eraser in DRAW, but here's the trick- 

set both the Fill and the Outline to white, set the tool to 
square. You might see a small black square as a cursor, but don't despair! Place 
your cursor (small black square) where you wish to 'erase' and click, which will 
essentially apply white paint to obscure the unwanted areas. 

Step 5:	 The final step ... using this technique, obscure the bottom of the shoulder, base 
of the nose, and part of the ear. Using the Paintbrush tool set to one pixel, draw 
in a mouth. Any other details you wish to add would be extra credit!

Step 6:	 Save your project, as you did with Draw projects 1 ~ 2.
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Project 4:		  Classroom Poster

Learning Objectives:	 Using clipart
				    Adding text
			   Send to front/back 

Setup:	 In the Chrome browser, go to sketch.io/sketchpad. 
Click the + button to start a new document, then, 
for the purpose of this assignment, chose 'Size of 
Screen'. Click to select the Create button.

Step 1:	 Click the Clipart button, then click 	
		  the Chose Graphic button to show 	
		  the library.

Step 2:	 Scroll through the (searchable) library then click on 
your choice of Clipart. Click on the canvas to place 
the image.

	 Using the Arrow tool (select) you can select the illus-
tration and enlarge it ad lib. If you lose the handles, 
simply click the object again.

Step 3:	 Select the Text tool, then click the Chose Font 
button to show the font selections.

Step 4:	 After you have clicked on your chosen font, your can-
vas will reappear. Draw a rectangle across the screen 
from left to right. to create a text field.

	

Step 5:	 Using the Selection tool, click on your text. You can 
resize and reposition your text using the handles. 
Double-clicking the text highlights the text in edit 
mode, so you can retype or add words.

Step 6:	 Save your project, just as you did with Draw proj-
ects 1 ~ 3.
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Project 5:		  Bubble Map / Flowchart

Learning Objectives:	 Creating shapes
				    Working with layers
			   Working with text 

Setup:	 In the Chrome browser, go to sketch.io/sketch-
pad. Click + to open a new document. Select 
the Shape tool. 

Step 1:	 Using the oval tool, draw a circle, ellipse (pre-
ferred), rectangle, or square.

Step 2:	 Draw (or duplicate if you want the same size) 
	 at least five shapes.

Step 3:	 Switch to the Text tool. Select a font and draw 
a text rectangle to match the size of your ob-
jects. TIP: It is easier to prepare the text block 
separately, then move it inside its shape.

Setp 7:	 Save your project, as you did with Draw projects 1 ~ 4.

Step 4:	 Type in your text. It may be overly large at first, 
but you can RESIZE it (after clicking on it with 
the Select tool). Repeat the process for all the 
other bubbles.

Step 5:	 Select the Brush tool and choose Arrow. You 
can set the thickness of the arrow with the size 
bar (a line with an arrow at the end of it). Turn on 
Curved if you want the ability to freehand draw 
the connecting lines.

Step 6:	 Draw connecting lines (the arrows show direc-
tion of flow or thought) among or between the 
bubbles.
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Project 6:	 Captured Image 

Learning Objectives:	 Importing images
				    Using Google Drive
				    Adding Text
			 
Setup:	 Using the Chrome web browser, go to Google.com

Step 1:	 In the search box, type:  moon 

	 When the search results appear, click the Images button.

Next, choose the Tools button.

 From the Color tab choose the Transparent option.

	

NOTE: Transparent images have what is referred to as an alpha channel, 
which means part of the image is see-through. Instead of getting a picture of 
the Moon with a solid background (illustrated on the right), the transparent 
version has a visible, circular moon with a transparent background (internet 
images are, by definition, rectangles). 

To the right is an image with an alpha channel background, so you only see 
the disk of the moon. 

To 'see'  the transparent background, a light grey checkerboard pattern is 
used, but fret not, it will not be visible when the image is used in a document.

Importing Images from the Internet

Sometimes you will want to create a document using images 
you found online. Say you are setting up an astronomy les-
son and you want a diagram of the Earth and Moon, or want 
to use that perfect photo you saw on the NASA website, this 
project will walk you through the steps to retrieve images 
(from Google Image Search) and place them in a document.
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Step 2:	 The next step involves moving the image you chose from your Google search 
to the Sketchpad document. 

	 This is a two step process and differs slightly,  
depending on what type of computer you are 
using. The Google search page displays an 
array of images. Clicking one of the smaller 
images brings up a larger version of the image, 
with additional details. It is this larger image 
you will save - there is no need to visit the 
website from where it came.

	
	 Move the cursor over the larger image and then 

alt-click on a Chromebook (right click on a Mac 
or PC) to invoke the drop down menu.

	 Choose Save image as... and click the SAVE button. 
The image is now in your Google Docs Downloads 
folder. On a PC the image will be saved in the Pictures 
folder, and on a Mac on the Desktop.

Project 6:	 Captured Image (Continued)

NOTE: Any time you save an image, you 
have the option to rename the file.
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Step 3:	 In the Chrome web browser, go to sketch.io/sketchpad. If the canvas is not 
blank, Click the + button to create a new document.  

	 Click the Clipart tool, then click the red 'Load Your Own Image' button 

 

	

	
	 You now have an image from the internet on canvas, ready to work with.

Step 4:	 Using shapes, text, brushes, etc. create an embellishment for your Moon im-
age. It may be a science illustration, a scene from a poem or story, or any other 
flourish you wish to add.

Step 5:	 Save your project, just as you did with Draw projects 1 ~ 5.

Project 6:	 Captured Image (Continued)

Select the Moon image and 
click the OPEN button.



54Paint & Draw for Teachers

Elective Projects:

The next few pages contain options for your elective assignments. Choose any three of the 
five assignments to complete. They are designed to be extensions of the skills you have 
already learned in completing the preceding PAINT and DRAW projects. 

You may simply recreate the projects exactly as shown, or modify them to suit your tastes. If 
modified, your work should contain the same general elements and construction techniques 
as the example. 

Consider this next series of assignments your 'final exam' in the course! Because of that, you 
will notice there are no 'step-by-step' instructions included for these assignments. But fret not, 
there should be no tools or techniques required to complete any of these projects that we 
haven't already covered in the course. Relax ... I know you'll do fine!

Elective Assignment 1: Chef's Choice	

Using either Cloudpaint, PaintZ or Sketchpad, create an original graphic, illustration or 
artwork.

Give your image an identifiable name (i.e. Chef's Choice) and click the Save button. The file 
will be saved into the downloads folder where it can then be transferred into your portfolio 
folder. If you wish to upload the file immediately, see pages 28 - 29.
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Elective Project 2: Picture Story

Using Sketchpad, create a 'fill in' story with the text tool and the Clipart library. Include at least 
five pieces of clipart in the story. You may want to watch the help videos on working with text. 

Add extras spaces in your text to make room for the Clipart. Place the cursor in the relevant 
location in your paragraph and press the spacebar. On some systems, use opt/alt while tap-
ping the spacebar to add more spaces.

Give your image an identifiable name (i.e. Elective 2) and click the Save button. The file will 
be saved into the downloads folder where it can then be transferred into your portfolio folder.
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Elective Project 3: New Territory 

If you are feeling adventuresome, try using a different computer graphics program (such as 
those illustrated on pages page 13, page 41 and page 60) to recreate any ONE of 
the projects in this workbook. For my benefit (and grading purposes) make sure you make a 
notation somewhere which program you used!

Give your image an identifiable name (i.e. Google Draw) and click the Save button. The file will 
be saved into the downloads folder where it can then be transferred into your portfolio folder.

Draw Project 5 in Google Draw

Paint Project 4 in jspaint.app

Draw Project 4 or Draw Project 6 in 
https://www.youidraw.com/apps/drawing/#
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Elective Project‑ 4: Forest 

Using the clip art library in SketchPad, create a forest scene. The forest should have a tree, 
clouds, and a distant horizon. For extra credit add some animals, people, or objects.

The ground and sky are rectangles, using a linear gradient fill. You can adjust the angle of 
the gradient change; in this case, the lighter portion of the green is at the top of the rectangle.

You will need to put some thought 
into the layer ordering, building the 
scene from back to front. Using the 
layer control, you can shift layers 
by dragging the icon up or down. 
I renamed the layers (by double-
clicking the name) for clarity.

Give your image an identifiable name (i.e. Elective 4) and click the Save button. The file will 
be saved into the downloads folder where it can then be transferred into your portfolio folder.
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Canvas: Portfolio Submission
If you chose to submit your Paint and Draw projects as a complete portfolio, I have illustrated 
the steps here:

Once you are logged into your Canvas account and have accessed the Paint and Draw for 
Teachers course, go to Module 8 - Standards and Evaluations, then click the Portfolio 
Submission link located under the video. 

At the bottom of the resulting page, click the Add submission button.

Click the folder icon. Here you create and name a new folder. After you type in a relevant 
title, click the Create folder button.

You should now see your self-named folder beneath the default 
'Files' folder. It is now a matter of opening your portfolio folder 
in separate window and dragging its contents (six Paint, six 
Draw and three elective images) into the Canvas folder you just 
created. It may take one or two minutes to upload, but you will 
see your list of files appear on the Canvas page. The process 
is the same on Mac, Windows and Chromebooks.

Windows Folder

Mac Folder

After the upload, click 'Save changes'
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Elective Project 5: Lesson Plan	

Subject of lesson:

Lesson Objective:

Lesson Activities:

Teaching Strategy:

Evaluation (Optional if lesson was not presented): Was the lesson objective met? Did all stu-
dents participate and complete the project? How was achievement measured? How would 
you modify the lesson in future presentations?

To fill out and submit this form, please go 
to the relevant link on the course website. 
A copy of your completed lesson plan will 
be automatically e-mailed back to you. 
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Other Graphics Programs

Through the Chrome Web Store or online, there are a multitude of other computer graphics 
programs available. Feel free to explore those listed below or do a search and find more!  

PhotoStudio for images (Chrome Store)

www.Photopea.com (online)

XPaint (Chrome Store) 

www.kleki.com

www.kidmons.com/game/paint-online

sumopaint (Chrome Store)       
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Project                  Draw #4 

Name of Project:   Class Poster

Standards Correlation Assignment
By designing graphic-enhanced lessons for your students using the experience gained from 
this course, you will fullfil several of ISTE's Technology Standards for Teachers. These have 
been defined as necessary tools for today’s teaching professional. This course does not ad-
dress any specific states’ technology standards. It does, however, reinforce the ISTE educator 
standards. It is important you understand these standards and their performance indicators, 
and can effectively apply them for practical use. You can find the standards detailed further 
at: www.iste.org/standards. Once the web page is loaded, scroll 
down a bit and click on the 'Learn More' link under the center 'Edu-
cators' column. You can also see the standards on the 'Resources' 
page of the course website.

For the purpose of this next assignment you will be asked to se-
lect any 3 projects presented in this course, then align them to the 
ISTE Educator Standards. 

You will be asked to record your findings for three (3) assign-
ments. To assist you in completing this project, please refer 
to the sample below. 

Example:

To correlate Draw Project #4, the "Classroom Poster," to the ISTE educator standard, the digit 
'5' indicates that the project meets standard 5  - "DESIGNER."

Next, the letter 'a' is the relevant Performance Indicator for Standard 5: "Use technology to 
create, adapt and personalize learning experiences that foster independent learning and ac-
commodate learner differences and needs. . ." 

In explanation of the rationale underlying the selections, annotated graphic-laden posters in 
your classroom engage varying learning styles of all ages.  

So, in putting it all together, this is how the completed Standards Correlation Chart would ap-
pear had you chosen Draw Project #4 - "Classroom Poster" 

NOTE: You do not need to explain the rationale behind your selections; I did so only to illustrate 
the concept. The same standards might apply to multiple projects / assignments.

		
Standard Number:            5. 
	
Performance Indicator:      a. 	
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Standards Correlation Chart

To fill out and submit this form, please go to the Standards Correlation link on the course website. 
This is reproduced here solely for demonstration purposes. 
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Post-course Survey

About how many hours did you spend completing 
the assignments?

Did you do the bulk of the work at home or at 
school?

If other than the demo, what program(s) did you use to complete the assignments?

Did you use a mouse or a trackpad to complete the majority of the projects?

Having used the major elements of computer graphics, which part do you find most useful? 
Why?

Have you thought of any curriculum specific uses for computer graphics? What are they?

To fill out and submit this form, please go to the Post-Course 
Survey link on the course website. I have copied the survey 
here merely for reference; you will submit your responses 
via the Course Website. 
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Course Evaluation

Did this course meet your expectations? Please 
briefly explain.

How do you feel about the structure of the course?  
Was it organized in an orderly way, making it easy 
to follow?  How would you improve the structure?

Have you any comments to offer about the assignments?

How did the workload of this course compare to that of other courses with equivalent units?

How did you hear about the course?

To fill out and submit this form, please go to the Course 
Evaluation link on the course website. I have copied the 
survey here merely for reference; you will submit your re-
sponses via the Course Website. 
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About Your Instructor ...
I was born in 1953 at the Presidio in San Francisco, California. 
The second child of Maj. John and Bette Jane Young, I was en-
thusiastically welcomed by my only sibling - a brother, six years 
my senior. After my dad retired from the Army he still had a touch 
of the wanderlust so we spent the next few years exploring Wyo-
ming and Colorado. In 1963 we settled in Durango where my 
brother and I spent our days climbing trees, skipping stones 
across the Animas River, and exploring the La Plata mountains, 
which were our backyard. 

In the late 1960s my parents moved back to the Bay area of 
California where I finished high school then went off to college, 
enrolling at California State University in Fresno. I majored in 
Mass Communications - a combination of English, Theater Arts 
and the technical aspects of radio, television and film produc-
tion. I had those typical, youthful aspirations of becoming a ‘rich 
and famous’ script writer and filmmaker. Upon graduation I part-
nered with a local film production company and spent  the next 
several years writing, producing and filming documentaries and 
television commercials.

A combination of the reality of parenthood and a souring econ-
omy in the early ‘80’s guided my decision to return to school to 
obtain my teaching credential. The birth of my daughter in 1983 
cemented my decision to opt for the stability of teaching over the 
uncertain world of the arts. I began as a classroom teacher at 
the same time computers were first being introduced to schools. 
I have always had an affinity for machines and gadgets so I soon 
transitioned from ‘traditional’ teaching to working with technol-
ogy in education; the best decision ever!

Within a year I was the Technology Teacher/Coordinator for a 
small high school; teaching programming in a lab and setting up 
local area networks. As technology evolved and became more 
affordable, the District purchased classroom computers and I, 
seeing the need, began writing record-keeping and database 
programs for teachers. 

By the early ‘90’s I was assisting with technology District-wide 
and speaking at regional and state conferences. It was at this 
time I began teaching summer and weekend seminars at Fresno 
Pacific University (then Fresno Pacific College) on integrating 
technology in to the classroom. Through membership in CTAP 
(California Technology Assistance Project) I also provided pro-
fessional development, planning, and implementation assis-
tance to help schools utilize technology to support teaching and 
learning. 

I have now retired from classroom teaching after more than 
30 years of service to Madera Unified School District. With my 
‘extra’ time, I develop new courses for Fresno Pacific. My wife, 
Becky, and I enjoy interacting with teachers from all over the 
country - we recently began traveling across the US on Amtrak 
and have already logged over 25,000 miles riding the rails, mak-
ing whistle stops at many of your hometowns!

Using a Steadicam during 
the filming of a commercial 
for a regional TV station in 
the days before gray hair! 
 

In San Francisco receiv-
ing California’s prestigious 
Golden Bell Award for an 
exemplary program in tech-
nology, with Madera Unified 
school board trustees.

My beautiful bride Becky, 
on our wedding day! After 
all these years she's still 
the love of my life (and the 
world's greatest cook!).

Taking a break at my desk 
at Madera Unified, while 
administering an early (circa 
1990) school-wide network.

Scuba diving (a passion of 
mine) with my daughter off 
the coast of Maui, in the 
beautiful state of Hawai’i.

Visiting the St. Louis Arch 
with my wife - a day trip from 
Indianapolis after our annual 
trip to the Indy 500.

Me with Becky’s family, in-
cluding her three children 
and all eight (so far!) of our 
grandkids, at Becky's par-
ents' 60th wedding anniver-
sary celebration.

Fishing the Animas River 
in Durango, CO, where my 
brother and I used to roam. 
Pretty nice catch! We only 
keep what we eat, and this 
one was delicious!
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DIRECTIONS FOR SUBMITTING A REQUEST FOR ONLINE GRADINGDIRECTIONS FOR SUBMITTING A REQUEST FOR ONLINE GRADING

FPU requires I submit your grade online. For me to do that you must first request online grad-
ing via your FPU account. When you’ve submitted your completed coursework (no sooner):

•	  Login to your account on the CPD website at https://ce.fresno.edu/my-account 

•	 Click on ‘Request Final Grade’

•	 Select this course from the list of ungraded courses in 
which you are currently enrolled

•	 Click the box confirming accuracy of the information

•	 Click Submit

•	 FPU will email me that you have completed the course and 
are ready to be graded 

Please submit your request for online grading the same day 
you submit your  final coursework (no sooner). I cannot submit 
your grade until online grading has been requested. 

If I receive your final coursework but you’ve yet to request online grading, expect a delay 
while I attempt to contact you in reminder. If you encounter technical difficulties with the on-
line grading system please contact FPU directly; I am unable to troubleshoot their system. 

Once I have submitted your grade to FPU I will notify you via email that this has been ac-
complished. Processing grades submitted electronically is not automatic; FPU strives to post 
grades the same day, but it may take up to 2 business days to certify and post your grade 
(FPU will email you once your grade has been posted). 

Prior to ordering a transcript, particularly a ‘RUSH’ transcript, verify your grade has officially 
been posted. Login to your FPU account and click Final Grade Report. If your grade in this 
course appears, print off your Final Grade Report (FPU no longer mails Grade Reports - you 
must print them out yourself) and proceed with ordering transcripts. 

If this course does not appear, although I notified you I submitted your grade, please contact 
FPU (1-800-372-5505) directly with your inquiry. It may be they are ‘holding’ your grade for 
whatever reason, typically if you are overenrolled.

I hope you found the course beneficial. Again and as always, thanks!


